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1 Revision History 

Based on feedback, in some cases modifications to this document are done after its initial 
release as part of the CodeWarrior Development Studio for Power Architecture Processors 
v10.4 package. 
 
Users are strongly encouraged to download the latest version of this document from Freescale 
Website. 
 

Date Description 

July 07th , 2014 Version provided with CodeWarrior Development Studio for 
Power Architecture Processors v10.4. 

July 11th, 2014 Version posted on Freescale website with minor updates 
and typo corrections. 

October 31st,2014 Updated all the links to align with new location of the project 
on Freescale Official Website. 

2 About This Release 

The new features described in this document are new relative to the last general availability 
release, CodeWarrior Development Studio for Power Architecture Processors v10.3.3. 

2.1 Version Information 
 

This document provides information regarding the content of CodeWarrior Development 
Studio for Power Architecture v10.4.  Areas covered include newly supported targets, most 
relevant new features and errata with workarounds.  
 

2.2 Getting Help 

2.2.1 Updates to Release Notes 

Any updates to this document after the release date will be posted on Freescale Website.   
 

2.2.2 Application Notes 

As a reminder, several Application Notes are available describing how to accomplish some of 
the commonly needed development tasks. Please check the Documentation tab regularly for 
new Application Notes. The currently available set of Application Notes includes the following: 

2.2.3 Getting Started Guides 

Use these documents to quickly get started with setting up boards, creating & debugging 
projects, collecting the trace data, or installing a service pack.  
 

 CodeWarrior for Power Architecture Processors - Getting Started (Updated) 
Explains how to install the CodeWarrior software, prepare the boards supported by the 
current release, and then create, build, and debug a simple project. 

http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=CW-PA&tid=CWH
http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=CW-PA&tid=CWH
http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=CW-PA&tid=CWH
http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=CW-PA&tid=CWH
http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=CW-PA&tid=CWH
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 CodeWarrior for Power Architecture Processors - Quick Start (Updated) 
Explains how to install CodeWarrior Development Studio for Power Architecture 
Processors and how to create and debug a simple project.  

 Using the Ethernet TAP Probe - Quick Start  
Explains how to set up the Ethernet TAP probe and create, build, and debug a simple 
project that uses this device. 

 Installing Service Pack for CodeWarrior Tools - Quick Start  
Explains how to install a service pack or an update for your CodeWarrior software 
running on the Windows platform. 

 CodeWarrior IDE - Quick Reference Card (Updated) 
Lists keyboard shortcuts and defines the purpose of major CodeWarrior IDE user 
interface elements. 

2.2.4 Comprehensive User Guides 

 
Use these documents to learn how to perform what to perform, solve the most common 
problems using the FAQs guide, or simply learn more about the built-in features.  

 Targeting Power Architecture Processors (Updated) 
Explains how to use the CodeWarrior development tools to develop software that targets 
the Power Architecture processors; includes examples, definition of target-settings panel 
options, and a debugging tutorial. 

 CodeWarrior for Power Architecture Processors - Frequently Asked Questions 
(Updated) 
Provides answers to the most frequently asked questions about the CodeWarrior IDE 
and the Power Architecture tools. 

 CodeWarrior Common Features Guide (Updated) 
Describes the CodeWarrior IDE and debugger features that are common across all the 
CodeWarrior products. 

 Power Architecture Simulator User Guide (Updated) 
Describes the software simulation models released with CodeWarrior Development 
Studio for Power Architecture Processors. 

 CodeWarrior TRK Reference (Updated) 
Describes CodeWarrior TRK and explains how to customize it for use with different 
hardware configurations. 

 Power Architecture Build Tools Reference (Updated) 
Explains how to use CodeWarrior tools to build programs. 

 Tracing and Analysis Tools User Guide (Updated) 
Explains how to use the tracing and analysis tools to analyze the performance of your 
programs. 

 EWL C Reference  
Documents the CodeWarrior implementation of the C standard library. 

 EWL C++ Reference  
Documents the CodeWarrior implementation of the C++ standard library. 

 MSL C Reference  
Explains how to use the MSL C standard library. Use this library with the GCC build 
tools. 

 MSL C++ Reference  
Explains how to use the MSL C++ standard library. Use this library with the GCC build 
tools. 
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 CodeWarrior TAP Users Guide  
Explains how to set up the CodeWarrior TAP debug probe so it can communicate with 
the debugger and the target hardware. 

 Gigabit TAP Users Guide  
Explains how to set up the Gigabit TAP debug probe so it can communicate with the 
debugger and the target hardware. 

 USB TAP Probe Users Guide  
Explains how to set up the USB TAP debug probe so it can communicate with the 
debugger and the target hardware. 

 Ethernet TAP Probe Users Guide  
Explains how to set up the Ethernet TAP debug probe so it can communicate with the 
debugger and the target hardware. 

 

2.2.5 Cheat Sheets 

 
Use these cheat sheets to complete moderate-to-complex tasks by following instructions that 
you execute real-time within the CodeWarrior IDE.  
 
Select Help > Cheat Sheets in CodeWarrior IDE to run a cheat sheet. 
 

 Create a Linux AppTRK Remote System  
Shows you how to create a Linux AppTRK Remote System. 

 Making C/C++ the IDE's Default Perspective  
Shows you how to make the C/C++ perspective the CodeWarrior IDE's default 
perspective. The default perspective is the one the IDE displays each time it starts. 

 Target Management via RSE  
Shows you how to perform target management via remote system explorer. It provides 
data models and frameworks to configure and manage remote systems, their 
connections, and their services. 

 Using the Flash Programmer  
Shows you how to create, configure, and run a flash programmer target task. 

 Using the Import Wizard  
Shows you how to create a project from a previously exported project set file by fetching 
the project contents from the appropriate repositories. 

 Creating and Debugging a Power Architecture Project  
Shows you how to create and debug a Power Architecture project using the New Project 
Wizard. 

 Modifying Build Properties  
Shows you how to modify project build properties to suit your needs. 

 Burning U-Boot to Flash  
Shows you how to burn U-Boot to the flash memory of a target board. 

 Creating and Configuring Performance Analysis Project  
Shows you how to create and configure a Performance Analysis project. 

 Creating, Debugging, Collecting, and Viewing Trace Data  
Shows you how to create, debug, collect, and view trace data on the P4080/P4040 
target. 

 Importing a Trace Data File  
Describes the process of importing trace data from an existing project into another 
project and viewing the data in the Trace Events Viewer. 
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2.2.6 Further Help 

If you have questions, issues, or want to provide feedback, please use the Freescale online 
support web page. To use this page, follow these steps: 

1. In a web browser, go to http://www.freescale.com/TechSupport 

Freescale’s Technical Support web page appears. 

2. On this page, click the Submit a service request online link. 

The New Service Request — Category/Topic page appears. 

3. From the Category dropdown menu, select Technical Request. 

4. From the Topic dropdown menu, select CodeWarrior (or other appropriate topic). 

5. Click Next. 

The New Service Request — SR Details page appears. 

6. In this page, enter the requested information.  

At a minimum, enter information in each field marked by an *. 

7. Click Submit. 

If you are already logged in, the Service Request Confirmation page appears. Go to 
the last step. 

If you are not already logged in, the Log-in page appears. 

8. If you are a registered member, login with your user name and password. 

The Service Request Confirmation page appears. Go to the last step. 

9. If you have not yet registered,  

a. If you want to become registered member, click Register Now and complete the 
registration process.  

The Service Request Confirmation page appears. 

b. If you do not want to register, supply your contact information in the I do not want 
to register - Provide contact information form and click Submit. 

The Service Request Confirmation page appears. 

10. Click Done. 

Your service request is submitted. 

3 New In This Release 

3.1 Licensing 
This release is distributed under a new End-User License Agreement. The EULA is displayed 
during product installation and a copy is located in the PA/License folder. Please read the 
contents of the document carefully before using this product. 
 
This version of release, v10.4 has a new license. A license upgrade is required when 
transitioning from v10.3.3 or earlier tool versions. 
 
Customers can obtain a license, if needed, by exercising the options listed in the Software 
Licensing section of the Freescale account.  
 

http://www.freescale.com/TechSupport
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Please consult http://www.freescale.com/cwregister for additional information regarding license 
registration and activation, or enter a service request with Category = “Software Product and 
Topic = “License Issue”. 

3.2 Documentation 
 
CodeWarrior Development Studio for Power Architecture Processors v10.4 documentation is 
now live on Freescale Infocenter ! 
 
One can also visit the Information Center using the following links on the PSP page: 

 Featured Documentation section CODEWARRIOR_PA_IC: QorIQ Processors (Eclipse 

IDE) Infocenter - Online Documentation in the Documentation tab. 

 
One can also download the PDFs for the respective documentation from the Documentation tab 
on the PSP page. 
 
 
Below is a summary of the most relevant updates done on the documentation: 
 
Targeting Power Architecture Processors  
 

 On page 31, Section 2.1.2, “Processor Page,” updated Figure 2-2, “Processor Page,” to 
show QorIQ_T2 device family 

 On page 60, Section 3.3, “Build Properties for Power Architecture,” updated Table 3-1, 
“Build Tools for Power Architecture Processor Families,” to include QorIQ_T2 device 
family 

 On page 82, updated Section 3.3.2, “GCC Build Tool Settings,” to add GCC PowerPC 
toolchain information 

 On pages 152 and 153, updated Section 5.5, “Memory Translations,” to mention 
“e500v2” 

 On page 197, Section 5.10.1, “Adding Memory Monitor,” added a new item to the 
bulleted list at the end of the section 

 On page 440, Section 13.2, “PowerQUICC II Pro Processors:” 
o Specified “8377” target under “e300c4” core category 
o Removed subsection, “Debugging Interrupt Handlers” 
o Removed a note mentioning “e300c1 cores” from subsection, “Working with 

Watchpoints” 

 On page 442, Section 13.3, “PowerQUICC III Processors,” added a new subsection, 
“Using memory configuration files for bareboard debugging” 

 On page 443, Section 13.4, “QorIQ Communications Processors,” removed “T1040” 
target 

 On page 445, Section 13.5, “T-Series Processors,” added “T1040” and “T2080” targets 

 On page 448, Section 13.6, “QorIQ Qonverge Processors,” added a new subsection, 
“Preventing debug halt requests caused by cross triggering cores” 

 Performed IDE updates on entire document 

 Added support for T1042, T1020, and T1022 devices  

 Updated GCC Build Tool Settings 

http://www.freescale.com/cwregister
http://www.freescale.com/TechSupport
http://www.freescale.com/infocenter/topic/codewarrior_processors/QorIQ.html
http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=CW-PA&tid=CWH
http://cache.freescale.com/files/infocenter/CODEWARRIOR_PA_IC.html?fpsp=1
http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=CW-PA&tid=CWH
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 Added a new section on JTAG diagnostics tests 

 Manual updated to support SDK 1.6 
 

CodeWarrior for Power Architecture Processors - Getting Started 
 

 On page 6, Section 1.1, “System Requirements,” updated Table 1-1, “System 
Requirements,” to mention “Ubuntu 13.10” operating system 

 On page 8, Section 1.3, “Supported Devices,” updated Table 1-2, “Supported Device 
Families and Targets,” to include QorIQ_T2 device family 

 Performed IDE updates on all the documents 

 Added support for T1042, T1020 and T1022 devices  
 

 
CodeWarrior for Power Architecture Processors - Quick Start 

 On page 1, updated “System Requirements” table to mention “Ubuntu 13.10” operating 
system 

 On page 4, updated path to default installation directory 

 On page 7, updated “Processor Page” image to show QorIQ_T2 device family 

 Performed IDE updates on all the documents 

 Added support for T1042, T1020 and T1022 devices  
 

 
Tracing and Analysis Tools User Guide 

 Configuration the EPU counters (Section 2.1.2.1, page no. 36) 

 Excluding symbols from data results (Section 2.3.5 and 2.3.1.7, page 89 and 84) 

 Source line level coverage in Critical Code view (Section 2.3.1.3, page 72) 
In addition to the support of above features: 

o LTTng User Guide removed  
o Support of User-Space tracing removed  
o Latest FSL Style guidelines were applied to the document 

 Performed IDE updates on the entire document 

 Added T2080, T1040 and T1042 to the list of supported devices 

 Added a new section 1.1 Limitations, which describes limitations of performance 
analysis and Trace. 

 

3.3 Build Tools 
 
This release version includes GNU GCC for Power Architecture version 4.8.2-r963.  
 

New features added:  
 Ported all patches and Freescale optimizations to gcc-4.8.x  
 Added builtin-isel documentation  
 Fixed an issue that builtin_iselXX would not be recognized on targets that also 

support Altivec builtins (e6500).  
 Optimized memcpy for e6500 32 and 64 bits, using Altivec instructions when 

possible.  
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 All optimized memcpy implementations (e500v2, e500mc, e5500, e6500) has 
been ported to newlib.  

 Optimized ‘strlen’ for e500mc and e5500 (64-bits only).  
 Optimized ‘memset’ for e6500 32 and 64 bits, using Altivec instructions when 

possible. 
 Updated e6500 32-bit ‘memcpy’ to use ‘ld’ instead of ‘lwz’ to improve 

performance. 

 
Following issues were fixed: 
 

 Fixed Internal Compiler Error on e500v2 target.  

 Fixed an issue with sign extended elimination optimization which was limiting 
Coremarks performance. 

 Improve Coremark & EEMBC automotive [matrix01 program] performance 
numbers: SSA coalesce fix to generate proper coalesce info for typedefs. 

 Improve EEMBC consumer [cjpeg & djpeg program] performance numbers: C11 
standard was restricting gimplifier to optimize self modifying expressions. Added 
this change under a flag '-fdisable-c11-self-mod-expr'. 

 ENGR00296060: Wrong macro definition for e6500 32bit target prevents gcc 
4.8.1 building projects correctly. 

 ENGR00292364: Cannot display local variables stored relative to frame base for 
C++ Linux Apps built with gcc 4.8.1 default DWARF4 

 ENGR00298583: Verify vector registers 
 
Complete details on the new features and other updates done by transitioning to gcc 4.8.1 with 
details on some of the features are available at: http://gcc.gnu.org/gcc-4.8/changes.html 
 
 
gcc 4.8.2 comes with  DWARF4 as default when generating DWARF debug information:  

 DWARF4 is now the default when generating DWARF debug information. When -g is 

used on a platform that uses DWARF debugging information, GCC will now default to -

gdwarf-4 -fno-debug-types-section. 

GDB 7.5, Valgrind 3.8.0 and elfutils 0.154 debug information consumers support 

DWARF4 by default. Before GCC 4.8 the default version used was DWARF2. To make 

GCC 4.8 generate an older DWARF version use -g together with -gdwarf-2 or -

gdwarf-3. The default for Darwin and VxWorks is still -gdwarf-2 -gstrict-dwarf.  

Note: 
GCC 4.7.2, continues to be available as service pack and can be installed: 

 via updater (like any previous build tool service pack) selecting: 
o FSL PA Build Tools - 

http://freescale.com/lgfiles/updates/Eclipse/PA10_4/com.freescale.pa.buildtools_win 

 
Switching between version of toolchain feature is available only at project level by changing the 
default toolchain (Project -> Properties -> Build Tool Versions) after the service pack with the 
desired version of the build tool was installed. 
 

http://gcc.gnu.org/gcc-4.8/changes.html
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3.4 IDE 
 
This release is based on Eclipse 3.7.1 (Indigo).  Several fixes/improvements were added since 
previous release v10.3.3. 
 
Some updates and fine tunings were done on the IDE side: 
 

 Increased JVM program memory for Eclipse IDE to avoid some rare cases in which  
users were seeing sudden IDE crashes with ‘Out of memory’ error message. 

 Added the support to Disassemble/Preprocess multiple files. 

 Creation Date information is now visible CodeWarrior Projects View . 

 Errors are now sorted by ID in Problems View by default. 

 Added Excel-style shortcut (F2) to edit local path in Path Mappings wizard. 

 A notification is now sent to the user in the Console View if there are no source files to 
compile. 

 Ability to define 'Clean set' where user selects which objects to clean and use the 'Clean 
set' instead of 'Clean all'. 

 Support to export/import file-specific compilation macros from one project to another using 
a simple text-based export format. 

 Generated disassemble file is now created under the right configuration folder. 

 Prevent creating a new project without selecting any core. 

 Restrict the Error column of the "Codewarrior projects view" to show errors and ignore 
warnings. 

 Fixed Indexer symbol navigation when working with multiple build configurations in a 
multicore project. 

 Ability to import nested projects into workspace by drag and drop the top level directory 
into CodeWarrior. 

 Automatic switching of the toolchain path in Tool Settings tab in case of a toolchain switch. 

 Allow user to fix entered broken paths in Tool Settings tab. 

 Make sure the Signals view content is updated in case it is not initially visible. 

 Support to use ECD tool in non X-Window mode. 
 

3.5 CCS 
 

Reset cores issues for T1040 rev1 QDS and T4240 rev2 QDS targets were fixed. 
 

Please note that old version of USBTAP and ETHTAP are not supported anymore – 
starting already with previous general available release v10.3.3. for T1040QDS. CWTAP and 
GTAP are the probes recommended. 
 

In fact, Freescale has discontinued the support for USBTAP and ETHTAP already 2 
years ago but they have continued to be available for older setups. Adding this support now for 
new products - as T1040QDS – is not possible due to technical limitations and therefore the 
CWTAP solution (over Ethernet or USB) is the recommended probe. 
  
 

http://www.eclipse.org/eclipse/development/readme_eclipse_3.7.1.html
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3.6 Product Independent Debugger 
 
The following Core Debugger features have been added in this release: 

 A new Debugger Shell "symbol" command to allow view of the address for global 
symbols. 

 A new command line tool for validating user updates in debugger xml registers and flash 
programmer configuration files: ddd_command.exe. 

 Friendly error message when importing old projects with unsupported target types. 
 
The following fixes were done: 

 "Declared Type" for registers in Expressions view is now correct. 

 Target tasks are not duplicated after workspace restart and they are not reappearing 
after restart once removed. 

 Path to other executables relative to <<ProjDirPath>>  was causing problems when the 
symbolic information was cached. 

 Breakpoints were randomly disabled when debugging – most visible seen during 
successive verification of the kernel debug. 
 

3.7 Power Architecture Debugger 

Probes Supported 

The following debug probes are supported in this release: 
- External USB TAP (UTAP) 

o Not supported for T1040 QDS, T104x RDB, T102x RDB 
- External Ethernet TAP (ETAP) 

o Not supported for T1040 QDS, T104x RDB, T102x RDB 
- CodeWarrior TAP / USB 
- CodeWarrior TAP / Ethernet 
- Gigabit TAP (GTAP) 
- Gigabit TAP (JTAG only) + Aurora (trace) 

New Devices Supported 

All the devices supported in the service packs on top of previous release v10.3.3 are supported 
and integrated inside 10.4. 
 
The changes comparing to v10.3.3 are highlighted in red.  
 
 

Device 
Name 

Device 
Revision 

Board Type Bare Metal 
Debug 

Linux Debug 

P5021 2.1 RDB Yes N/A 

P5040 2.1 RDB Yes N/A 

P1010 2.0 RDB Yes Yes 

P1010 2.0.1 RDB-PB Yes Yes 

P1014 2.0 RDB Yes Yes 
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T4240 2.0 QDS Yes Yes 

T4160 2.0 QDS Yes Yes 

T4240 1.0/2.0          RDB Yes Yes 

T4160 1.0/2.0 RDB Yes Yes 

T2080 1.0 QDS Yes Yes 

T2080 1.0 RDB/PCIe Yes Yes 

T1040 1.0 QDS Yes  Yes 

T1040 1.0 RDB Yes Yes 

T1042 1.0 RDB Yes Yes 

T1020 1.0 RDB Yes No 

T1022 1.0 RDB Yes No 

C29x 1.0 PCIe Yes Yes 

8536 1.1 DS Yes Yes 

 
Complete list of IC/boards supported is available on: InDepth section of the PSP section of 
Freescale’s Website. 
 
Note: 

 “Linux” Support implies Linux kernel debugging and Linux application debugging.  
“Bare Metal” Support implies U-Boot debugging out of NOR flash, register and memory access, board 
initialization and flash programming for the flash device on the board. 
 

Debugger Alignment SDK 1.6 (Linux Kernel 3.12) 

 
The debugger was updated and verified for Linux Kernel Debug and Linux Application 

debug to work with latest version SDK 1.6.  
 

SRAM configuration (e500v1/v2, e500mc, e5500, e6500) 
 

New project wizard is available to enter in debug using the SRAM. This can be used 
when encountering problems with DDR or an initialization of DDR. The initialization is done only 
for what is vital for a debug session and for the flash devices on the board and it can be used for 
small applications. 

Note that SMP debug is not recommended to be used in SRAM configuration as usual 
SMP applications are larger than SRAM size. The use case is however present but it is into the 
user’s responsibility to make sure SRAM size is not overrun. 
 

MMU Awareness 

The debugger can now actively monitor the target MMU and read the currently active 
translations. This MMU awareness feature is activated only if there are no translate directives 
defined in the memory configuration file or if the memory configuration file is not specified at all. 
The MMU awareness for bare metal is supported for processors based on e500mc, 
e5500,e6500 and starting this release also on e500v2 cores. The debugger can now also 
automatically detect MMU changes and re-resolve affected breakpoints. 
 Note that during testing we have noticed a performance penalty when resolving software 
breakpoints/stepping during Linux module debug operations. Occasionally we have noticed a 
delay of several seconds between successive steps depending on the probe/setup. 

http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=CW-PA&tid=CWH
http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=CW-PA&tid=CWH
http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=CW-PA&tid=CWH
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As that might be annoying when debugging, a solution is to define a mem file with the 
following configuration: 

 
<filename>.mem 

  
AutoEnableTranslations true 
translate v:0x0 i:0x0 0x0 

 
Note that this issue is visible only for Linux Module Debug. 

 

Cache way locking/unlocking support 
 

Debugger now supports cache lock/unlock operation on several way configurations (the 
user can choose any desired configuration from a list) for e500mc, e5500, e6500 cores. 
 

Flash Programmer improvement 
 

A Flash Programmer improvement was obtained for Flash Programmer operations by 
increasing the target memory buffer size of each target. This improvement is available for 
e500v1/v2, e500mc, e5500 and e6500 cores. 
 
 

Thread names for Linux Kernel Debugging 
 

For Linux Kernel debugging, the debug view shows now the real name of each 
thread.  The old Thread [ID: <id>] was replaced with Thread [<name>:<id>]. 
 

More information in Debug view for Linux Application Debugging 
 

For Linux Application debugging, the title line for each thread in Debug view contains 
now information about the name and the lwpid of the thread, apart from the CW number. The 
pattern for the title line is Thread [<cwnumber>:<lwpid>:<name>] (<stateinfo>). 
The information about the state of a thread was modified in case a signal is received such that 
the real signal name and description is shown. For SIGSEGV case Signal “Exception 11” 
received. Description PowerPC Exception is replaced with Signal “SIGSEGV” received and 
Description: Invalid memory segment access. 
 

Unstripped library path for AppTrk 
 
In order to avoid overwriting stripped libraries with their unstripped version, AppTrk can be run 
with ‘-p’ parameter followed by the path where to look first for unstripped libraries.  
The AppTrk usage is now: 

 apptrk [-v] [-p library_path] [:tcpport | serialdevice | ‘|’]. 

3.8 B4/T4 Instruction Set Simulators 
No significant updates were done on the simulators. 
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3.9 Trace, Profiling and Performance Analysis 

New Devices Supported 

 

Device 
Name 

Device 
Revision 

Board Type Nexus 
Trace 

Performance 
Analysis 

P5021 2.1 RDB Yes(Aurora) Yes 

P5040 2.1 RDB Yes(Aurora) Yes 

T4240 2.0 QDS Yes(Aurora) Yes 

T4160 2.0 QDS Yes(Aurora) Yes 

T2080 1.0 QDS Yes Yes 

T2080 1.0 RDB/PCIe Yes Yes 

T1040 1.0 QDS Yes N/A 

T104x 1.0 RDB Yes N/A 

 
 
Please see below complete details on how T2080 QDS can be configured: 
 

1. RCW on board must have Aurora enabled (SERDES port #2) and the speed set 
to 2.5 Gbit/s (RCW bit 180 must be set to 1) 

2.  DIP switches on the board must be configured for Aurora lanes routed to Aurora 
connector on the board:  

 SW4.[5:6]=11[Default]  

 SW4.[7:8]=11[Default]  

 (SERDES2 Clock1 and SERDES2 Clock2 -> 100 MHz) 

 SW8.[4:5]=11 (SERDES2 Protocol muxed to Aurora) 
 
 
 
Additional SA updates: 
 

 Also the issue regarding PA10 decoding of P4080 trace, which was showing wrong 
Timestamp values was fixed. This was done by adding an option in the Trace and Profile 
tab to enable accurate timestamps when the trace was not fully decoded (i.e. on-the-fly 
decoding in the trace viewer). 
 

 Fixed the issue with Nexus messages remaining stranded in the NPC (e.g. trace 
collection until the program reaches a breakpoint). Flushing the NPC buffer before 
collecting fixed this issue. 
 

 EPU performance counters are now configurable from SA GUI for P4. 
Added the options to configure EPU performance counter registers in the 
Trace Configurations UI. The configurable registers are: 

 EPCCR0-31 (Event Processor Counter Control Register 0–31) 

 EPCMPR0-31 (Event Processor Counter Compare Register 0–31) 

 EPCTR0-31 (Event Processor Counters 0–31) 

 EPCAPR0-31 (Event Processor Counter Capture Register 0–31) 
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3.10  Wizard 
 
The wizard has been updated to include all the newly supported platforms: 
 

 Bare Metal - T1040QDS, T104x RDB, T102x RDB, T2080QDS, T4160RDB, T4240RDB, 
P1010/14 RDB-PB 

 Linux/Application Debug: T1040QDS, T104x RDB, T102x RDB, T2080QDS and C29x 
 

Two small updates to increase clarity were added: 

 For Simulator projects made using the New Project Wizard the connection type field now 
displays the connection used by the simulator (e.g. CCSSIM2 ISS) instead of None  

 Welcome screen improved with links directly to the Project Importer on the Examples tab  
 
 

3.11  Installer 
 
Ubuntu 13.10 64bit is now supported by the installer. 
 
The installer must be run as root due to the CW dependency install mechanism. However, if the 
installer is not started as root it will inform the user about this requirement. 
 
The installer now tries to automatically install the dependencies required by CodeWarrior to run. 
In case of a failure the user is directed to the README.txt file which describes the steps needed 
to manually install the dependencies. 
 
The installer now automatically starts in console mode instead of failing in case the GTK2 32bit 
libraries are missing (this was a common issue occurring on 64bit host operating systems) and it 
tries to install them during the dependency install phase. 
The GUI installer is now mapped 1 to 1 with the console mode. This means that all the screens 
present in the GUI installer are also present in the Linux installer. 
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4 Important Usage Notes and Known Limitations 
 
This section describes some issues that are more likely to be encountered, and how to avoid or 
work around them. Additional information on errata and work-arounds can be found in the Errata 
section of this document. 

4.1 General 

Installer Path on Linux 

A limitation in the InstallShield technology prevents the installer from running if the path to the 
setuplinux.bin executable contains a space.  

Using CodeWarrior on 64-bit Linux Hosts 

 
To run the installer in graphical mode on 64-bit Linux Hosts the 32-bit GNU libc and Xorg 
libraries must be installed, otherwise the setup will start in console mode. Please consult the 
README file accompanying the installer for per-distribution instructions 

New Project Wizard and Fedora 18 

The New Project Wizard has occasionally been found not to display connection related controls 
in the user interface. To work around this limitation please proceed with project generation and 
adjust the probe information in the RSE Connection panel. 

SELinux 

CodeWarrior will not run on SELinux as this configuration prevents the IDE from loading needed 
libraries. The following are possible work-arounds: 

 Avoid using SELinux, if this is a possibility 

 In the SELinux configuration, allow the loading of so's with writable and executable 
segments (e.g., on RedHat 5, see SELinux Management, Boolean-Memory 
Protection-Allow all unconfined executables to use libraries requiring text relocations) 

Project Resource Removal and Ubuntu 

The IDE has a limitation related to removing resources (files, folders) from CodeWarrior Projects 
view on Ubuntu 11.04 hosts. This limitation has not been observed with Ubuntu 12.x. 
 

Ubuntu Themes 

CodeWarrior UI (Flash Programmer in particular) may display incorrectly if the host OS is 
Ubuntu 10.x/12.x accessed over a remote connection (ie. VNC). Changing the host OS desktop 
theme to anything but Ambiance or Radiance has been found to alleviate the issue. 
 

OpenJDK incompatibility 

OpenJDK is not supported by CodeWarrior. Users are advised to either install an Oracle Java 
Virtual Machine, or use the one bundled with CW. 
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Fedora 18/19/20 

The New Project Wizard has a known limitation related to the inability to display some controls 
in the probe configuration panels. Users are advised to proceed with the project generation, 
then manually adjust probe specific details from the debugger connection panels. 

4.2  Debugger 

4.2.1 General Limitations 

 
For kernel module debugging, the software breakpoints which are set in a module are not 

always enabled for all cores the second time the module is inserted. As a workaround check the 
disabled breakpoint entry or remove and set again the breakpoint. 
 

After debugging several times a SMP project, debug operation might fail with the following 
error: “Invalid input value.”. The workaround would be to restart CW. 
 

For e6500 cores any cache operation on L2 Cache from Cache Viewer window works only 
for the cluster that includes the current selected core. The workaround is to select from Debug 
View a core from the L2 cluster on which you want to perform a cache operation. 

 
An error occurs at reading cache data on shared caches from a secondary core when the 

first core is running. The workaround is to stop all the cores that share the same cache before 
performing any cache operation on that cache. 
 

The initialization and memory files for u-boot provided with CodeWarrior are not kept in sync 
with the latest SDKs and some variations on the initializations (values of RCW usually) might be 
present. The user needs to update those files in order to debug u-boot successfully on latest 
SDK versions. 
 
   SMP debug is not recommended to be used in SRAM configuration as usual SMP 
applications are larger than SRAM size. The use case is however present but it is totally into the 
user responsibility to make sure SRAM size is not overrun. 
 
  During testing we have noticed a performance penalty when resolving software breakpoints or 
stepping during Linux module debug operations. Occasionally we have noticed a delay of 
several seconds between successive steps depending on the probe/setup. 

As that might be annoying when debugging, a solution is to define and use a mem file 
with the following configuration: 

 
<filename>.mem 

  
AutoEnableTranslations true 
translate v:0x0 i:0x0 0x0 

 
Note that this issue is visible only for Linux Module Debug. 

Debugger Limitations for G4/B4 device families 

The following features are not supported for the B4 device families: 
- Breakpoint cross-triggering 
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- Reset Configuration Word override 
 

Debugger Limitations for T4 device families 

 
If using the FPGA image version 6 on PROTO4 the debug operation fails with the error -> 
“T4240: HRESET occurred during transaction” when doing the reset_to_debug command. 
Changing the FPGA firmware to previous versions unblocks the debugger operation. 
 
The following features are not supported for the T4 device families: 

- Breakpoint cross-triggering 
 

For the T4240 rev. 1 QDS in particular, please note that the Reset Configuration Word cannot 
be fetched from NOR flash. This is a hardware limitation. 
 
The factory FPGA image shipped with T4240 Proto3 boards is incompatible with CodeWarrior 
(ENGR00234909). Symptoms of the incompatibility include: 

- A faulted core immediately after reset 
- Inability to stop the platform immediately after reset 
- Stepping failures immediately after reset 
- Inability to use the Flash Programmer 

Proto4 boards do not exhibit any of these issues. Proto3 users are advised to upgrade the 
FPGA image to a version later than T4240QDS_1011_1755_release.  

Secure Debug (P4080) 

If you provide a wrong key and an unlock sequence is run by the debugger with the erroneous 
key, the associated part will be locked permanently and you will need to reset the target to 
connect again. 

Stepping limitations in low-power states on P4080 

The Doze and Nap core states are reported by CW while target is in one of the two power 
management states. When resuming (either run or step) the core will get back in the same 
state. While the debugger is able to detect and display the low-power state of the target even if 
running, it is not recommended to use step operation while being in any of these two states. 
Please note that on P4080 Rev 1 low power states don't work reliably. 
 

E500v2 ISS simulator limitations 

[e500v2 ISS] Execute reset option is not supported on e500v2 ISS simulator [MTWX42060]  
 

Debugger compatibility with TightVNC 

* Debugger fails to start in Linux machine if Tight VNC is running. You can workaround this 
problem by downloading  rgb.txt from  
  http://cvsweb.xfree86.org/cvsweb/xc/programs/rgb/rgb.txt and copying it to /etc/X11/rgb.txt. 
 
Additional information here:  https://lists.ubuntu.com/archives/ubuntu-uk/2007-
April/004337.html. 

http://cvsweb.xfree86.org/cvsweb/xc/programs/rgb/rgb.txt
https://lists.ubuntu.com/archives/ubuntu-uk/2007-April/004337.html
https://lists.ubuntu.com/archives/ubuntu-uk/2007-April/004337.html
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Hypervisor Guest Application Debug 

The download scenario for SMP/AMP guest Linux kernels is not supported [189274]. For 
debugging guest Linux kernels from entry point use an Attach Launch Configuration to attach to 
the target, set a HW breakpoint at 0x0 and then restart the partition. 
   

Debug over Aurora 

The GigabitTAP probe can be reliably used with CodeWarrior in the following scenarios: 
- Run control over the JTAG interface 
- Trace extraction over JTAG interface 
- Trace extraction over Aurora interface 

Although partially functional on B4860 targets, debugging over Aurora interface has known 
stability issues and is therefore not supported. 

 Import Elf Wizard Limitations 

A dtb file cannot be imported within the wizard and the user has to do this from GUI. Also SMP 
cores cannot be selected. 
 

P2041RDB Kernel Debug: 

 
When executing Kernel Attach to a running u-boot after already ran Linux Kernel on the board 
and executed a soft reset, CW shows that Linux Kernel is running on target instead of displaying 
a warning which states that a different executable is executed on target.   
     
Workaround:  

I. Run a hard reset. 
II. Configure u-boot to initialize the DDR with DEADBEAF. 

1. Append P2041RDB:ECC_INIT_VIA_DDRCONTROLLER,MEM_INIT_VALUE to 
the line corresponding to P2041 board 
from  build_p2041rdb_release/tmp/work/p2041rdb-fsl-linux/u-boot-git-
r27/git/boards.cfg 
The line must look like this: 
P2041RDB                     powerpc     mpc85xx     p2041rdb            freescale      -         
  P2041RDB:ECC_INIT_VIA_DDRCONTROLLER,MEM_INIT_VALUE 
2. Compile the u-boot: bitbake -c compile u-boot -f 
3. Run: bitbake u-boot. The new u-boot image will be located in 
build_p2041rdb_release/tmp/deploy/images. 
 

 

4.3  Software Analysis 

4.3.1 General Limitations 
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Trace collection over Aurora is not functional yet for B4420. Work is in progress to figure 
out the root cause for the failure of collection. An initialization issue is suspected. 

Performance Analysis is not yet available for T104x. 

P2040/P2041 Aurora Trace Collection  

Currently due to an issue while training Aurora probe the collection of trace over Aurora 
does not work for P2040/P2041 without a workaround.  

Following steps must be taken to train correctly the Aurora probe and be able to collect 
the trace: 

1. Start a debug session using JTAG and select the train_aurora.tcl init file in the 
connection settings. Make sure that you select the correct jtag config file.  

2. After the board stops at the start of main file, open the Debugger Shell window by 
selecting Window > Show View > Debugger Shell, and run the following command (similar to 
the reset_to_user command run from CCS console: protocol ccs::reset_to_user  

3. Reset the probe from telnet and wait for the CCS connection to re-establish.  
4. Terminate the current session from CodeWarrior and debug again. 

 
Complete description of the Aurora training sequence for P2040/P2041 is available in Tracing 
and Analysis Tools User chapter 2.4 Preparing Aurora Interface for Collecting Aurora Nexus 
Trace. 
 

4.4  B4/T4 Instruction Set Simulators 

4.4.1  General Limitations 

 
Following limitations are currently known: 
 

1. B4860ISS: LAW configuration can be done only via configuration file, at initialization 
time, not at runtime 

2. B4860ISS: The PA side is implemented but not fully verified. 

3. T4240ISS is supported currently only in Linux64 

4. The Linux images were not updated to the latest available by Freescale 

5. B4860 SoC reset - not supported, need to restart the simulation 

ENGR00237053 - [SC10.4.4] B4860ISS cores are not able to restart separately in 
multicore debug scenario 

6. B4860 e6500 core reset - not supported 

7. T4240 hardware breakpoints not supported (ENGR00232437) 

8. Watchpoints issues with the CW for PA: 

MTWX52001 - [B4860ISS/e6500] Watchpoints with Read or Read/Write attributes 
don't trigger 

MTWX52700 - [B4860ISS] Only watchpoints of thread#1 are hit in a multicore 
scenario  

MTWX52836 - [B4860ISS] Watchpoints on float variables are not hit  

9. Other known issues: 

ENGR00236321 [Multicore] crcpe test on multi-core fail 
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ENGR00274258 [SDOS Use Cases] [multicore, iterations=1, debug/release] 
maple_eTVPE demos get stuck 

5 System Requirements 
Hardware  
 

 Windows® OS: Intel® Pentium® 4 processor, 2 GHz or faster, Intel® Xeon™, Intel® 
Core™, AMD Athlon™ 64, AMD Opteron™, or later 

 Linux® OS: 1.8 GHz Intel® Pentium® class processor (or better) 

 At least 2 GB of RAM. 

 At least 3 GB of free disk space. 

 Free USB port for use with installation media. 

 Internet connectivity for web downloads and update access. 
 
Operating Systems 
 
Ubuntu 13.10/64 bit support was newly added in this release. 
 

Windows       

Host OS SP Level 32-bit 64-bit 

Windows 7 SP1 x x 

Windows Vista SP2 x x 

Windows XP SP3 x x 

Windows 8   x x 

 

Linux       

Host OS Version 32-bit 64-bit 

RedHat Enterprise Linux 5.4 x x 

Ubuntu 13.10  x 

Ubuntu 12.04 x x 

Ubuntu 11.04   x 

Ubuntu 10.10 x x 

Ubuntu 10.04   x 

SuSE 11 Server 11 x   

Fedora 18   x 

RedHat Enterprise Linux 6.3   x 

OpenSUSE 12.3 12.3   x 

Debian 7.1 7.1   X 

 
Note: Some other Linux distributions may be used, but would require some manual identification 
and installation of the missing, required libraries. 
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6 Errata 

As this is an internal release the complete list of known issues is available along with the 
complete list of issues fixed in this release. 

6.1 Issues fixed in this release 

ID Component Headline 

ENGR00282877 CCS 
CCS is not support Lock cache for L3 
cache Bank 2 

ENGR00276877 CCS 
B4860 QDS rev2 L3 bank 1 - 
Lock/Unlock is not working 

ENGR00266060 PA-DEBUGGER 
CW crash - intermitent on a particular 
setup on one machine only. 

ENGR00284107 PA-DEBUGGER 

[B4460QDS][B4860QDS][REV2][Kernel] 
At some point CW might crash when 
selecting bp break point windows after 
remove module 

ENGR00234410 PA-DEBUGGER 
The ROM target hanged in SPI flash in 
the usr_init1 function 

 
Note: In the above listing are only the exceptions from the previous release. Real number of 
defects fixed is considerably higher. 

6.2 Known Issues For This Release 
 

ID Component Headline Details/Workaround 

ENGR00274128 CCS B4 full RCW override is not working 
RCW can be written in the 
flash. 

ENGR00316804 
DEBUGGER-
CORE-ECLIPSE 

[Linux App debug][Exec project] 
Error when adding global variable. 

No workaround. 
 

ENGR00300406 PA-DEBUGGER 

[PA 10.3.4][T4240QDS][L2Cache] 
Debugger shown data of L2 Kibo 
caches of all clusters are as well as 
data of the cluster that Debug view 
is foscusing 

A cluster can be disabled if 
a core for that cluster is 
selected and the disable 
operation is performed. In 
debug view selection of  
the current core has to be 
done to be able to perform 
the operation. 

ENGR00291107 PA-DEBUGGER 
[PA10.3.3][T4240QDS rev 2]Error 
after debug SMP several times 

Workaround is to restart 
CodeWarrior. 

ENGR00321938 PA-DOCS 
[PA10.4.0]Help system can not 
display some webpages 

Issue is not always 
present but in case it 
shows up the workaround 
is to open the link into a 
new window. 

ENGR00303713 PA-SA 
[PA 10.4.0][GUI] Exclude Symbols 
tab is empty in Ubuntu 

Issue only on Ubuntu. No 
workaround available. 
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